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Introduction

This paper is a sequel to my “Learn Information Gathering By Example”.
This paper will go through looking for Vulnerabilities in remote system(s), which is what you would
do in a Penetration Test after gathering information on the target. I will be using real world
examples for nearly everything in this paper.
Although I covered scanning a network range for possible targets in my last paper I will cover it
again in this paper, because it is related. I am aware that 99.5 % of people will already know how
to do this, and should know how to do it. For the sake of complete beginners I will cover it again.
Not everything covered in this paper is entirely legal to do in some countries to remote
machines with out the owner’s permission.

Note:

I have not been able to include everything I wished to include in this paper due to time limitations
(and of course there were other factors.)
I may publish small papers in the future on subjects relating to Penetration Testing that I originally
wanted to include in this paper.
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Host Discovery

For the sake of this paper I will assume you have already gathering the information on the target,
and have an IP Range to scan.
The network range I will be scanning is: 64.152.0.0 - 64.159.255.255
This range belongs to Claria a company which recently merged with the Spyware company
Gator or Internet marketing as they like to call themselves. Before I continue I would like to
mention that that this is nothing malicious and I am purely gathering information on the target.

I will be using Angry IP Scanner to perform this scan.
We open up Angry IP Scanner and we then enter the IP Range.
We enter the starting range which is 64.152.0.0 and then the IP address we want to scan to,
which is 64.159.255.255.
Download Angry IP Scanner: http://www.angryziber.com/ipscan/

Options -> Select Ports
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We will also select to scan each host to see if Port 21 is open.

Now before we begin we have to select the information we want to recover when doing a scan.

Options -> Select Columns

For this scan I will just choose, Hostname, Comp. Name & Group Name.

Now we begin the scan.
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At the end of the scan we find that Claria (The Spyware company) appears to be hosted on the
same server as a lot of pornographic websites.

Mostly gay pornographic websites I may add.

Wouldn’t surprise me at all if Claria was hosted on the same group of servers as a lot of
pornographic websites. Although more investigation would need to be done into this to determine
if they are on the same server. And of course why they are on the same server, does Claria own
these websites? Anyway back on topic.

We can export our scanning results by going

File -> Export all …

We are now ready to move onto the next stage of the Penetration Test. Keep in mind though that
of course this paper is not meant to cover really anywhere near what you would be doing as a
professional penetration tester doing an audit.

For legal reasons, I will conduct the next part of this paper against a completely different
host.
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Banner Grabbing/OS Detection

We are now going to go through OS detection and Banner Grabbing.
We are going to use a program called nmap to determine the Operating System of the remote
host. nmap is available for numerous platforms such as Windows, Linux, Solaris, FreeBSD &
Mac. So what ever operating system you have, you should be able to use nmap. As well as
gathering information on the services running and versions of the software behind them.
nmap has many useful features that you can enable by passing the program an argument relating
to the option you want enabled. Below I am going to list, the most important options you may wish
to use.

Download nmap: http://insecure.org/nmap/

-sT – TCP Full Connect Option

-sS - TCP Syn Scan Option

-sU – nmap will also scan UDP Ports (warning this won’t give entirely reliable results.)

-O - Operating System Detection (TCP/IP Fingerprinting)

-sV - Service Version Detection

-P0 - Don’t Ping The Host, Just Scan It

-F – Do A Fast Scan On The Target Host(s) (Scans on the ports in the nmap services file.)

-p - Choose the ports to scan from e.g. 0-65535

-n – Don’t do a reverse DNS lookup

-T - [0-5] Set timing template (higher is faster.)

-S – [IP Address] Spoof Sender IP Address (Your IP Address.)

-v – Verbose Output

-A – Aggressive, use both OS Detection and Service Version Detection.

-vv – Very Verbose Output

What Is A TCP Full Connect Scan?

A TCP full connect scan to put it simply is where the port scanner you are using will try and
connect to each port you specify to scan (or possibly a range of ports.) If the scanner is unable to
establish a connection to that port, it will assume it is closed.

What Is A SYN Scan?

A Syn Scan is some what similar to a TCP Full Connect scan. To understand what a Syn scan is
you must first understand what a “Three-way Handshake” (relating to TCP) is.
http://support.microsoft.com/kb/172983/EN-US/
Although I have referenced the Microsoft website, this applies to any application that uses the
TCP Protocol (just thought I would note that for beginners who might be unsure.)
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A SYN Scan simply sends a SYN packet to a port on the target host and waits for a response.
Once it receives the response it does not bother to make the connection.

What Is ACK Scanning?

An ACK scan works by sending ACK packets to each of the remote ports.
If there is no response from the target host or if no ICMP destination unreachable packets are
received the port is considered to be filtered (by a Firewall or similar device/software.)
If a response is received the port is considered to be unfiltered.
ACK scanning will not actually determine whether or not a port is open, only if it is filtered
by a Firewall (or something similar.)

What Is RST Scanning?

RST scanning is similar to ACK scanning except RST packets are sent to the target host.
RST scanning may be useful to bypass some Intrusion Detection Systems.
A RST packet is usually used to reset a TCP Connection.
There are other types of scans nmap can do, however I won’t bother to cover them in this paper
(search Google if you really want to know.)

nmap is very easy to use, below is a screenshot of me doing a TCP Full Connect Scan, with OS
Detection & Service Version Detection.

Screenshots of the scan I did against the target host:.

As you can see I used the options –F –A –P0 –vv

I used those options because I wanted the scan to be fast, the output to be as detailed as
possible and I wanted to get information on both the services running and the hosts operating
system. I also added in –P0 incase the host doesn’t respond to ICMP
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packets.

Above is some of the information nmap return, such as Operating System & Services
running on various ports.

How Does Operating System Detection Work?

nmap is able to detect the operating system of the target host by doing something which is
referred to as TCP/IP Fingerprinting. Which is sending numerous (generally speaking) types of
packets to the remote host and based on how the host respond making an educated guess on
the operating system and service pack/kernel version.

SYN/ACK Packet Time Stamp Analysis

nmap probes the target host and gets it to send several SYN and ACK packets back to nmap.
nmap then checks the timestamp of the packets. Different operating systems will increment the
value in the packets timestamps at different rates. Based on this nmap could make a decision as
to what the target hosts operating system is.

Web Server Banner Message

nmap (I am assuming this) may also gather information from the banner given out by the web
server. For example if the target machine is running IIS 5.0, it would very obviously be a Windows
2000 machine. (The only exception would be if the machine was giving out a fake banner, which
isn’t unheard of.)

Information From TCP Packet Headers

nmap also gathers numerous other pieces of information from the headers of TCP packets.
Such as TTL (Time To Live), SYN/ACK (as mentioned above), Flags.

I am not going to explain all of this in detail, as it is beyond the scope of this paper, I
suggest using Google to get more information on the subject of TCP/IP Fingerprinting.



Aelphaeis Mangarae Blackhat-Forums.com

Brute Forcing Services

Introduction

In this part of the paper I am going to demonstrate how to Brute Force passwords using different
software. For the most part (If not all), most of this will be done using tools on Windows. However
I may decide to show some on Linux (If it is really worth it.)
To sum up what Brute Forcing is, Brute Forcing is the process of connecting to a certain service
using a certain protocol and attempting to authenticate yourself using random generated
passwords. Sometimes however the passwords that are attempted are simply from a word or
dictionary file.

Advantages/Disadvantages Of Brute Forcing:

Advantages:

*If the user is known to use weak passwords, brute forcing may prove to be a very effective way
of breaking into a machine.
*If you have a fast connection and fast proxy (If you choose to use one) Brute Forcing can be
quite a fast process.
*It is very easy to do, and often effective on targets you wouldn’t normally think would have weak
password security. (If you’re a hacker, you have probably experienced finding out how lame some
people’s passwords are.)

Disadvantages:

*It can take along time if you have a slow Internet connection or using a slow proxy.
*It will with out doubt fill up the log file of the remote machine, if the Administrator for some reason
believes he has been breached and checks the log files. He will know for sure someone has
attempted to break in. And he will also know what method of entry they used (If you penetrate the
machine from Brute Forcing a password for a certain service.)
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FTP Brute Forcing:

Download Brutus: http://www.hoobie.net/brutus/

Due to the fact that this paper will already be long enough as it is, and this is a really simple thing
to do I will not be showing too many screenshots.

1. First enter a target which you wish to Brute Force, and select FTP. (Make sure of course
that the target Is actually running FTP first.)

2. Type –> FTP

3. Port -> 21 (Or what ever port the FTP server is running on.)

4. Connections -> I would probably leave the amount of connects at 10, but if you have a
fast Internet connection, you can adjust it. I would recommend playing around it actually
to get a sense of what your Internet connection can handle (what is optimum.)

Note: Some FTP servers will not allow more than one connection at a time. (This also goes
for other Protocols/Servers.)

5. Check Use Proxy -> Define
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Port 9050 Is The Port The TOR Socks Proxy Uses

6. Choose a Single Username or point Brutus towards a .txt file that contains a list of
possible usernames. I would recommend making up this .txt file yourself.

7. Choose a password list, either that or choose Brute Force and define a range.

I would personally recommend using a dictionary/word file attack against the target first before
resorting to Brute Forcing, as it will take significantly longer.

Press Start! And the Brute Forcing Begins.

Brute Forcing Telnet, POP3, SMB

You can easily brute force these by doing everything mentioned above and simply choosing
another protocol.
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Brute Forcing Terminal Services

What Is Terminal Services?

Terminal Services or Terminal Server Edition (TSE) is a component of Microsoft Windows NT
operating systems (both client and server versions) that allows a user to access applications or
data stored on a remote computer over a network connection. Terminal Services is Microsoft's
take on server centric computing, which allows individual users to access network resources
easily.

Based on the Remote Desktop Protocol (RDP), Terminal Services was first introduced in
Windows NT 4.0 (Terminal Server Edition). The products Windows 2000 Server, Windows 2000
Advanced Server, Windows 2000 Datacenter Server and Windows Server 2003 have introduced
several improvements and new features. Microsoft used Terminal Services in Windows XP for the
Remote Assistance feature. Windows XP (Professional Edition only) includes a single-user
Terminal License using the Remote Desktop feature.
Remote Desktop Connection for Windows

Microsoft provides the client software Remote Desktop Connection (formerly called Terminal
Services Client), available for most 32-bit versions of their Windows operating systems and
Apple's Mac OS X, that allows a user to connect to a server running Terminal Services. Third-
party developers have created client software for other platforms, including the open source
rdesktop client for common Unix platforms. Both Terminal Services and Remote Desktop Protocol
use TCP port 3389 by default.

Source:
http://en.wikipedia.org/wiki/Terminal_Services

How Do We Brute Force Terminal Services?

As you should now know (If for some reason you didn’t know before) brute forcing is a pretty
simple process that is automated.
We are going to use a program called TSGrinder to brute force terminal services.

Download TSGrinder:
http://blackhat-forums.com/Downloads/Software/tsgrinder-2.03.zip
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tsgrinder.exe –w C:\dict –u Administrator –n 2 10.0.0.4

TSGrinder Explained:

Command Explanation
-w C:\dict.pw Tells TSGrinder that the

dictionary file that is going
to be used is located at
C:\dict.pw. By default your
dictionary file will be called
dict, not dict.pw.

-u administrator Tells TSGrinder to brute
force the password for the
administrator account.
Note: Just because an
account is called
administrator doesn’t
mean it is an administrator
account.

-d domain.com This would be used if we
wanted to tell TSGrinder
what domain the target
machine is on. In this case
my other machine is not
on a domain.

-n 2 Tells TSGrinder to
connect to the report
machine with two threads.
If we wanted to use
multiple threads.
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Logging Onto The Remote Machine:

This can be done by using the Microsoft Remote Desktop Client in Windows.
Start -> All Programs -> Accessories -> Communication -> Remote Desktop Connection
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SMTP Enumeration

We can enumerate SMTP servers simply by using telnet. I will walk you through doing simple
enumeration on an SMTP server (this is advanced as it gets.)

We first telnet mail.bigpond.com 25
(This is just an example; obviously you can do this with any SMTP server.)

We get two useful pieces of information from this, first a host name “onto01ps.mx.bigpond.com”
and second the SMTP server software being used “ESMTP server”.

We now say “HELO” to the server.
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We now tell the server, the FROM address to use.

The address adm1n1strat10n[AT]hotmail[DOT] is accepted. Which is interesting because the
email address is not of the same domain as the SMTP server.

We now enter an address to send mail to:

It does not accept an email address outside of it’s own domain.
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We now enter an address inside of the bigpond.com domain:

We find we cannot send mail to the address because it does not exist.

We will now connect to the server again and attempt to impersonate Aelphaeis@bigpond.com

We find we need authentication to send mail from an address in the bigpond.com domain.
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Conclusion

1. Server software used: ESMTP server

2. The server does not allow you to impersonate a bigpond.com email address; you need
authentication to send from an email that is of the bigpond.com domain.

3. The server does not allow you to send to non-existent bigpond.com email addresses.

4. The server allows you to send from what ever address you want, apart from @bigpond.com
addresses.
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SMB Enumeration

What Is SMB?

SMB (Server Message Block) is an application level protocol which is used for network shares,
printer sharing and serial ports and typically runs at TCP Port 445.
SMB runs on top of the NetBIOS protocol which runs on the Session Layer of the OSI.
http://en.wikipedia.org/wiki/OSI_Model
NetBIOS allows computers to communicate over a network and typically runs at TCP Port 445.

What Is Meant By SMB Enumeration?

The purpose of SMB Enumeration is usually to get access to network shares or shared printers.
Of course information before this is usually gathered. Such as Share Name(s), Computer
Name(s), Group Name(s) etc.

We can use a tool that comes with BackTrack called “smbgetserverinfo” to gather some
information.



Aelphaeis Mangarae Blackhat-Forums.com

This information given to us could be used and sometimes need with some SMB enumeration
tools, there are probably near a hundred, so I won’t document a lot of them.
If you’re enumerating SMB the chances are your goal is to get access to some password
protected shares.
For this we can use a tool called NAT (NetBIOS Auditing Tool.)
http://www.securityfocus.com/tools/543

NAT.exe –o C:\Results.txt –u userlist.txt –p passlist.txt 202.134.2.16

Doing this would hopefully give us a list of shares and their usernames and passwords.

Of course the user/pass lists that come with NAT are very small, you may wish to open the up
with Wordpad (because that’s how their formatted) and add some more user/pass combinations
to them.
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Web Server Fingerprinting

What Is Web Server Fingerprinting?

Web Server fingerprinting is simply the process of trying to obtain information about a web server
which you may wish to audit for vulnerabilities.
Things you may wish to learn about the web server are: Type, Operating System it is running on
Version, Extensions/Mods and Whether or not it supports SSL.
Originally I was planning to go through manually detecting all of the above, or using an array of
tools to accomplish the gathering of information. However I found a program called httprint that
does the job perfectly!

What Is httprint?

httprint is a tool that can be used to do Web Server Fingerprinting.
It is available for Windows, Linux, FreeBSD & Mac OSX.
However the GUI version is only available for Windows.
I will go through using the command line version for Windows (you should stay away from GUI’s,
the command line most of the time will allow you more control.)

Download httprint:
http://net-square.com/httprint/
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List Of Options/Commands for httprint:

httprint v0.301 (beta) - web server fingerprinting tool
(c) 2003-2005 net-square solutions pvt. ltd. - see readme.txt
http://net-square.com/httprint/
httprint@net-square.com

Usage:

httprint {-h <host> | -i <input file> | -x <nmap xml file>} -s <signatures> [...
options]

-h <host> host can be either an IP address, a symbolic name,
an IP range or a URL.

-i <input text file> file containing list of hosts as described above
in text format.

-x <nmap xml file> Nmap -oX option generated xml file as input file.
Ports which can be considered as http ports are taken
from the nmapportlist.txt file.

-s <signatures> file containing http fingerprint signatures.

Options:

-o <output file> output in html format.
-oc <output file> output in csv format.
-ox <output file> output in xml format.
-noautossl Disable automatic detection of SSL.
-tp <ping timeout> Ping timeout in milliseconds.

Default is 4000 ms. Maximum 30000 ms.
-ct <1-100> Default is 75. Do not change.
-ua <User Agent> Default is Mozilla/4.0 (compatible; MSIE 5.01;

Windows NT 5.0.
-t <timeout> Connection/read timeout in milliseconds.

Default is 10000 ms. Maximum 100000 ms.
-r <retry> Number of retries. Default is 3. Maximum 30.
-P0 Turn ICMP ping off.
-nr No redirection. Do not automatically follow 301,

302 responses. Enabled by default.
-th <threads> Number of threads. Default is 8. Maximum 64.
-? Displays this message.
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What I want to do now is finger print a web server and output the results as a HTML file.

httprint.exe –h Maddox.xmission.com –s signatures.txt –o E:\
HTTP_Fingerprint_Report.html

After the scanning is done we get a nice HTML report that looks like the following:

You don’t have to output the report if you don’t want to, you can just have a look at it on the
command line. However if your doing a comprehensive penetration test you may wish to keep a
log of what you found in the form of a HTML report.
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Web Based Vulnerabilities

Vulnerabilities in web based and web server related software is very common. And is often the
point of entry for an attacker.
We will be looking at gathering information on web based applications and web server related
software such as CGI’s.

Mapping Out Directory Structure

The first thing we are going to do is map out the directory and file structure of a website.
This can be done using a program (win32) called IntelliTamper.
http://www.intellitamper.com/download.php
There are programs that can map out and download the contents of a website, but for now we will
just look at IntelliTamper. It may not be important for you to download the contents of a website;
using IntelliTamper may prove to be stealthier than download the entire website.
Of course If an administrator was to check his logs and see an IP Address mapping out his file
and directory structure it would of course be suspicious.

IntelliTamper is very simple to use, it is just a matter of firing it up and entering the website to
map. However before we start we may wish to configure the options.

You may wish to increase the number of maximum connections used by the program in order to
do the scan faster. Of course if you wanted to be a tiny bit stealthy you may wish to just use one
connection.
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There are some options you may or may not wish to turn on, also check out the other tabs.
IntelliTamper can be configured to use a proxy.

You may wish to add to the dictionary file that comes with IntelliTamper before firing it up.



Aelphaeis Mangarae Blackhat-Forums.com

As you can see we have gathered some important information. We have gathered a directory
structure as well as a list of directories where directory listing is denied. IntelliTamper has been
able to gather a list of some (possibly all) of the files in some of the directories.
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Mirroring A Website To Your Hard Drive

How Does This Work?

This works simply by mapping out the website in a very similar way to IntelliTamper then
downloading all the files to your hard drive.

What Software Can Be Used?

For mirroring a website to your hard drive you can use a program called Teleport Pro.
http://tenmax.com/teleport/pro/download.htm

When the program starts up, a Wizard is displayed; we are going to use the wizard.

We now have to follow a series of steps.

1. Enter the path to start from, click next.

2. Select what you wish to download from the site.

3. Click Finish.

We then go Project -> Start and start the process of mirroring the websites contents to our hard
drive.
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Results:
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Using Nikto

What Is Nikto?

Nikto is an Open Source web server scanner which performs comprehensive tests against web
servers for multiple items, including over 3200 potentially dangerous files/CGIs, versions on over
625 servers, and version specific problems on over 230 servers.

So What Exactly Can Nikto Be Used For?

Nikto can be used for finding potentially dangerous files. Nikto is sort of like an automated version
of an audit done looking for folders and files that may be of interest to an attacker. Nikto should
always be used in conjunction with the tools I have documented above.

Updating Nikto

Updating Nikto is fairly simple, the command is nikto.pl –update

Before doing this of course you will have to first navigate to the Nikto directory in BackTrack:
/pentest/scanners/Nikto-1.35

After doing the update command Nikto should update itself from cirt.net.
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Launching Nikto

Launching Nikto is really simple, Nikto does however have many options to choose from. But for
the purpose of demonstration I will just show a simple scan.

Download Nikto: http://www.cirt.net/code/nikto.shtml
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Nikto Commands/Options
- Nikto 1.35/1.36 - www.cirt.net
+ ERROR: No host specified

Options:
-Cgidirs+ Scan these CGI dirs: 'none', 'all', or a value like '/cgi/'
-cookies print cookies found
-evasion+ ids evasion technique (1-9, see below)
-findonly find http(s) ports only, don't perform a full scan
-Format save file (-o) Format: htm, csv or txt (assumed)
-generic force full (generic) scan
-host+ target host
-id+ host authentication to use, format is userid:password
-mutate+ mutate checks (see below)
-nolookup skip name lookup
-output+ write output to this file
-port+ port to use (default 80)
-root+ prepend root value to all requests, format is /directory
-ssl force ssl mode on port
-timeout timeout (default 10 seconds)
-useproxy use the proxy defined in config.txt
-Version print plugin and database versions
-vhost+ virtual host (for Host header)
+ requires a value

These options cannot be abbreviated:
-config+ use this config file
-debug debug mode
-dbcheck syntax check scan_database.db and user_scan_database.db
-update update databases and plugins from cirt.net
-verbose verbose mode

IDS Evasion Techniques:

Directory self-reference (/./)
3 Premature URL ending
4 Prepend long random string
5 Fake parameter
6 TAB as request spacer
7 Random case sensitivity
8 Use Windows directory separator (\)
9 Session splicing

Mutation Techniques:
1 Test all files with all root directories
2 Guess for password file names
3 Enumerate user names via Apache (/~user type requests)
4 Enumerate user names via cgiwrap (/cgi-bin/cgiwrap/~user type requests)
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Fuzzing For SQL Injection Vulnerabilities

Fuzzing For SQL Injection:

Fuzzing for SQL Injection can be done by simply breaking out of an SQL Query (Of course there
are other ways as well.)
Breaking out of an SQL Query will usually make the web application send an error back to the
user. Of course in software with any real type of security, this wouldn’t happen.
But many web application programmers fail to implement secure coding practices.

Breaking Out Of The Query:

Breaking out of the query can be done by inputting a character which is used by the application to
separate things such as text and variables. This will cause the query to end and most probably
cause the server to spit out an error message.

Characters That Can Be Used To Break Out Of The Query:

'
"
''
'"
\'
\"
%00'

How To Input Special Characters:

Breaking out of an SQL Query can easily be performed by entering one of the above characters
into an input box.

Input Boxes on Hotmail Shown
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And As An Argument To PHP:

As you can see the site above did not spit out an error or message of any sort.
This is of course doesn’t mean 100% that it isn’t vulnerable to SQL Injection, assuming of course ‘
(Single Quote) is the character used to break out of an SQL Query.
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Error Messages In Relation To Probability Of SQL Injection Vulnerabilities:

Keyword % Chance Of Being Vulnerable (Approx.)
sqlexception 98
runtimeexception 95
error occurred 95
runtimeexception 95
NullPointerException 90
org.apache 90
stacktrace 90
potentially dangerous 90
internal server error 80
executing statement 80
runtime error 80
exception 80
java.lang 80
error 500 75
status 500 75
error report 70
incorrect syntax 70
sql server 70
server error 70
oledb 60
odbc 60
mysql 60
syntax error 50
tomcat 45
sql 40
apache 35
invalid 20
incorrect 20
missing 10
wrong 10

Note:

I got these above figures from a group of penetration testers (Secure Systems Lab.) I altered
them slightly because I wanted them to seem more reasonable.
However I am not a Penetration Tester (I have done Penetration Tests though) but I have not
memorized which queries are signs of a higher probability of the web application being
vulnerable.
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SQJ Injection White Papers:

Blind SQL Injection Are Your Applications Vulnerable:

http://www.spidynamics.com/assets/documents/Blind_SQLInjection.pdf

SQL Injection Are Your Web Applications Vulnerable:

http://www.spidynamics.com/assets/documents/WhitepaperSQLInjection.pdf

Advanced SQL Injection In SQL Server Applications:

http://www.ngssoftware.com/papers/advanced_sql_injection.pdf

SQL Injection Walkthrough:

http://www.securiteam.com/securityreviews/5DP0N1P76E.html

SQL Injection Are Your Applications Safe:

http://www.sitepoint.com/article/sql-injection-attacks-safe

Blindfolded SQL Injection:

http://www.imperva.com/download.asp?id=4
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Automated Vulnerability Scanning

What Is Automated Vulnerability Scanning?

Automated Vulnerability scanning is when a piece of software is used to find vulnerabilities on the
target host. There are many popular Vulnerability scanners such as Max Patrol, Retina, Nessus
and Shadow Security Scanner.
Vulnerability scanners are usually used by penetration testers in conjunction with manual auditing
of potential vulnerabilities.

Why Not Just Use An Automated Scanner?

The reason penetration testers do not just use automated scanners is because they usually don’t
find all vulnerabilities. They are designed to look for the vulnerabilities built into the scanner, in
other words common vulnerabilities. Although some scanners such as Max Patrol do have
heuristic analysis (But even then manual testing is still highly recommended.)
Automated scanners also make a lot of “noise” on a network; if a Penetration Tester is trying to
remain hidden he/she doesn’t want the logs of the target host to filled up with information.

Max Patrol
http://maxpatrol.com/

After starting up Max Patrol and right click on Scanned Hosts we get some options that can lead
us to places to enter information on target hosts.
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If we wish we can add a Class C range by going to Add Range.

I would recommend (if you are going to scan a range) to only scan active hosts (hosts that
respond to ping packets) unless your scanning your local network. The reason is that it would
take an awful lot of time scanning every host (that means including the ones that don’t respond at
all, and probably are non-existent.)

Once we have added a host, we can start a scan by right clicking and going Start, we can also
choose to do a scan of a specific service.

After the scan we are presented with a tree of information on each service running on the target
machine and vulnerabilities in those services.
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Before doing a scan however I would recommend playing around with the scanning profile to get
the most out of your scan.

Profile -> Edit Current

These are the things I recommend changing:

*[Hosts look-up] - scan non-responsive hosts (for Single IP Addresses only.)
*[Vulnerability identification] – Enable banner-based vulnerability reporting.
*[Vulnerability identification] – Check known DoS attacks (may wish to untick.)
*[HTTP] – Hide from IDS.
*[Script analyzer] – Advanced checking of application scripts
*[Discovery Methods] – Check, Referrer, User-Agent, Cookie.
*[Authorization] – Use extended dictionaries of logins and passwords.
*[FTP] – Use extended dictionaries of logins and passwords.
*[POP3] – Use extended dictionaries of logins and passwords.
*[MySQL] – Use extended dictionaries of logins and passwords.
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Now I will show you an example of using Nessus (Security Scanner, which I would expect
you would already know.)

http://nessus.org/

We start off by entering the hostname of the target we wish to scan.

After entering the host which you wish to scan press next and we will move onto the next phase
of using Nessus.
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This screen is where we choose what plug-ins we will use in the scan.

Now if you are scanning something on the same network as you, you may wish to select:

Enable all plugins with default settings

This will basically do the most complete scan Nessus can possibly do. However beware that you
will be using some things which are considered dangerous by Nessus. I have never had any
problems with any of these, but I can only assume that some of these things may crash certain
services when vulnerabilities are discovered.

If you’re using the same version of Nessus as I am at the moment you will see the option:

Choose a predefined policy (You should use Manage Policies to create one first)

I think it would be a good idea to use a predefined policy so I am going to walk you through it.

Manage Policies -> Add a new policy

Once you click Add a new policy, you will be prompted to enter a name for the policy.
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Once we have selected a name for our policy we go to Edit settings. And we are presented with
the following screen:

There are only a couple of things that need to be changed here.

[General]

*Thorough tests needs to be enabled (Disabled by default.)

[Ping]

Do an ICMP ping.

That was simple wasn’t it?

Now before we move onto scanning, we need to select what plug-ins we use.
We can do this by going to Manage Policies -> Edit plug-ins.
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I personally recommend checking them all, which can be done by clicking the tick at the
top.

We now need to go back to the start, enter our host again and select:

Choose a predefined policy
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We now get to the following screen, where we select the server to use for doing our Nessus scan.

We can simply choose the localhost (unless you have a server running somewhere else.)
You should have started the Nessus server earlier, if you haven’t run it now.
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We now get a screen showing us the scans progress:

At the end of a scan we get a HTML report like the following:



Aelphaeis Mangarae Blackhat-Forums.com

Analyzing Firewall Rules

Access Control Lists (In Relation To Firewalls)

An Access Control List is very simply a set of rules that enforce a security policy for a firewall.
Access Control Lists can filter things such as access to Local Ports from remote machines,
Remote ports that can be used to connect to ports on the system. As well as Remote IP
Addresses that are allowed (or even IP Addresses from the same network) to access certain
machines on the network. Of course this is only a brief explanation of what Firewall ACL’s are
and what they can do.

What Is Firewalking?

“Firewalking” is a technique used to gather information on the ACL of a remote network’s firewall.
The way Firewalk works is some what similar to traceroute, as in it can see which hosts will allow
packets to travel through them. Of course Firewalking is more complex than traceroute as it is
meant to analysis Firewall ACL’s.

What Is Trace Route?

Traceroute works by increasing the "time-to-live" value of each successive batch of packets sent.
The first three packets have a time-to-live (TTL) value of one (implying that they make a single
hop). The next three packets have a TTL value of 2, and so on. When a packet passes through a
host, normally the host decrements the TTL value by one, and forwards the packet to the next
host. When a packet with a TTL of one reaches a host, the host discards the packet and sends
an ICMP time exceeded (type 11) packet to the sender. The traceroute utility uses these returning
packets to produce a list of hosts that the packets have traversed en route to the destination.
traceroute may not list the real hosts, it indicates that the first host is at one hop, the second host
at two hops. IP does not guarantee that all the packets take the same route.
http://en.wikipedia.org/wiki/Trace_route

Obtaining The Metric

Before we do a firewalk we will need the metric, the machine a hop before the target server. To
do this we can use traceroute (tracert on Windows.)

tracert h4cky0u.org
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Using Firewalk
firewalk –n –S21,23,80 –pTCP h4cky0u.org 64.224.0.16

We use –n, to specify we don’t want IP Addresses resolved to host names. –S is used to specify
the ports to be checked. And –pTCP specifies we are to use TCP.
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As you can see we didn’t manage to gather much information. Of course we have only tried it on
one target. Try it yourself on a random target just to see what results you get.
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Stealth – Hiding Behind Numerous IP Addresses

When doing Penetration Testing (with written permission) the people requesting the pen test may
not alert everyone (all of the network administrators) as to if the test is taking place.
Therefore it would be wise to conduct the test in a stealthy manner (to simulate a real full scale
attack.)
One way of doing this would be to hide behind numerous IP Addresses that come from around
the world.

Why would we do this?

This would make the network administrators (if they bothered to check their logs and IDS logs)
that some of the penetration attempts are simply script kiddies from foreign countries scanning for
a particular type of exploit. If the administrators of a network see 100 different attacks from the
same IP Address they are going to know that someone is attempting (and putting a lot of effort in)
to penetration and “0wn” their network.

How would we do this?

We could do this simply by hiding behind numerous socks proxies. However it is often time
consuming to find such proxies. Although if you really wanted to go to an effort what you could do
is scan Turkish IP Ranges for proxies and make it look like you’re a Turkish Script Kiddie trying to
break into the network. The network administrators would see your Turkish and instantly assume
you’re pathetic.

To do this we are going to use a program called TOR “An anonymous Internet communication
system”.
http://tor.eff.org/

After installing TOR we start Vidalia which is a GUI for the Win32 TOR.

By right clicking on the TOR icon in the quick launch we can start the TOR service.
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Refresh a list of TOR servers.

Now after starting the TOR service and allowing TOR to grab a list of TOR servers to run through,
we can use TOR to route SOCKS & HTTP connections.
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TOR Socks Port: 9050

TOR HTTP Port: 8118

When using TOR make sure to have Privoxy open as well to cloak your DNS requests.

It may still be worth while scanning foreign IP ranges for Socks Proxies.

Ports you may wish to scan for:

1080, 8080.
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Utilizing Public Exploits

Introduction

In this section I will explain the basics of different types of vulnerabilities. There are literally
hundreds of different types of vulnerabilities, so I will not be covering anywhere near all of them.
However I will be covering the most common vulnerabilities found in software, and explaining the
basics of them. And then for people who are absolute beginners I will explain how to use public
exploits. Exploits released for the public domain normally come In a few formats, C/C++, Perl,
PHP & Python.

Note: Some people may think my intention by doing a section like this may be to help
script kiddies. I can assure you nothing is further from the truth. Generally script kiddies
don’t read papers such as this, so I don’t expect many, if any at all to benefit from this.

I can guarantee you, you won’t gain any respect by using this information to deface
websites. The only reason I provide this information is for people who wish to use this for
legitimate purposes, such as auditing their own machines.

Web Application Vulnerabilities:

SQL Injection:

To put it simply, SQL Injection works by breaking out of the query being performed. Another
command or query is then “Injected” which then performs an action an attacker wishes to carry
out. Sometimes however the attacker simply breaks out of the query then attaches something
afterwards in order to make the query evaluate to true. This is usually done in order to
authenticate the attacker.

Command Execution

Command Execution can occur when global variables are turned on and a string is passed to an
un-initialized variable in the application. This string is formatted so the function it is passed to
executes it as a system command. This type of vulnerability could also occur in Windows &
Linux software (besides web applications, of course how the vulnerability would be
exploited would be different from web applications.)

Cross Site Scripting (XSS)

XSS is a vulnerability in web applications where code can be injected into a web application
which is executed on the client side. In order for any type of attack to be successful the client’s
web browser (or other application) must be able to run the code inputted into the web application.
There are 3 types of XSS, each of them some what similar to each other.

Type 0 XSS

This type of XSS is where potentially malicious code (that is passed to the web app) is generated
via a Client side script on the victim’s machine.
This vulnerability is also referred to as DOM-based or Local cross site scripting. Because of the
fact these scripts are in the “Local Zone” (In Internet Explorer) it is possible that remote code can
be executed.
This type of vulnerability would be executed with the privileges of the user’s browser.
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Type 1 XSS

This type of XSS is a non-persistent vulnerability and is by far the most common XSS
vulnerability discovered in web applications.
This vulnerability usually occurs when a web application accepts data from a user with out
validating it and then gets server-side scripts to process the code inserted.

Type 2 XSS

Type 2 XSS is something which is stored on the server permanently (or at least until the admin
removes it.)
An example of this would be when a user posts an XSS in a post on a forum. Anyone viewing that
post will be exploited.

Remote/Local File Inclusion

File inclusion vulnerabilities in web applications are usually very easy to find.
The vulnerabilities occur usually when data is able to be inputted into variables with out being
validated. The variables are then passed to a function such as include() fopen() require() etc (In
PHP applications.)

Directory Traversal

Directory Traversal can occur when input is not validated and is inserted into a variable.
The variable is then passed to a function that for what ever reasons accepts a path to a folder or
file (inside a variable.)
The characters in the variable will traverse will cause the application to traverse to a high
directory. This is usually done by sending a request to the web application like the following:

GET /vulnerable.php HTTP/1.1
Cookie: VARIABLE=../../../../../../../../../etc/passwd

The “../” will cause the application on a UNIX machine to traverse to a higher directory,
on Windows “..\” is usually used.
This vulnerability also effects applications other than Web Applications.
The Windows API will also usually accept UNIX-like directory traversal characters.



Aelphaeis Mangarae Blackhat-Forums.com

C/C++ Vulnerabilities

Stack Buffer Overflow

A stack based buffer overflow occurs when more data is inputted into a variable than what the
actual variable was declared to hold.
Here is an example of some vulnerable code:

#include <stdio.h>
int main(int argc,char *argv[])
{
char buffer[50];
printf(“This program is vulnerable to a Buffer Overflow\n”);
strcpy(buffer,argv[1]);

return 0;
}

If more than 50 characters was passed to this application as an argument a stack overflow would
occur.
This is called a stack overflow because this is an overflow on the stack.
http://en.wikipedia.org/wiki/Stack_%28data_structure%29

Data is written to areas on the stack that normally wouldn’t be written to.
The purpose of a stack overflow may be for an attacker to overflow local variables and therefore
influence the way the program operates. Usually the goal of a stack overflow is to overwrite the
EIP (Return Address.) Flow of the program can then be hijack and shellcode can be executed.

http://en.wikipedia.org/wiki/Shellcode

Heap Overflow

A heap overflow is a buffer overflow that occurs on the heap section of memory.
Memory on the heap is dynamically allocated by the application at run time and usually contains
program data. It is possible as has been demonstrated for code execution to occur as a result of
a heap overflow.

http://en.wikipedia.org/wiki/Heap_%28programming%29

Format String Vulnerabilities

Format string attacks are a new class of vulnerabilities discovered around 1999, previously
thought harmless. Format string attacks can be used to crash a program or to execute harmful
code. The problem stems from the use of unfiltered user input as the format string parameter in
certain C functions that perform formatting, such as printf(). A malicious user may use the %s and
%x format tokens, among others, to print data from the stack or possibly other locations in
memory. One may also write arbitrary data to arbitrary locations using the %n format token, which
commands printf() and similar functions to write back the number of bytes formatted to the same
argument to printf(), assuming that the corresponding argument exists, and is of type int * .

Format bugs arise because C's argument passing conventions are not type-safe. In particular, the
varargs mechanism allows functions to accept any number of arguments (e.g. printf) by "popping"



Aelphaeis Mangarae Blackhat-Forums.com

as many arguments off the call stack as they wish, trusting the early arguments to indicate how
many additional arguments are to be popped, and of what types.

http://en.wikipedia.org/wiki/Format_string_bug

Shellcode Payloads:

Shellcode Payloads are simply the payload of the shellcode executed (What the Shellcodes
actually does when run.)

Bind Shell:

A shell is bind to a port for you to connect to.
Commonly telnet is used to connect to a bind shell.

Reverse Connect Shell:

The shell spawned from the Shellcode reverse connects to your computer.
Netcat is usually used to listen on a port for the connection.
Using Reverse Connect Shell payloads usually helps getting past routers.

Execute Command:

Sometimes the payload of a Shellcode will just be to execute a system command.

URL Download Shellcode:

It is common that shellcode in browser exploits downloads a file and executes it.
This could be used in any type of exploits and isn’t restricted to browsers, email clients etc.

DLL Injection:

Attackers may wish to inject a dll into another program so when the dll is loaded is it run with
higher privileges. The DLL may do things such as spawn a VNC server.
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Exploit Usage:

PHP

Using exploits coded in PHP is very simple. All you have to do is upload the PHP exploit to a host
that supports PHP. You then load up the location of the file in your web browser.
The host your exploit is on must allow PHP to be able to connect to other servers,
otherwise the exploit won’t work.

Perl

The usage of Perl exploits is almost as simple as doing:

Perl exploit.pl argument1 argument2
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As you see above I pass the exploit the two arguments which it was programmed to take, it then
attempts to exploit the target. Obviously /forum/ on site.com doesn’t exist so it fails.

If you are on a Windows box you may use ActiveState’s Active Perl to run and compile Perl
scripts into executables.

http://activestate.com/Products/ActivePerl/?mp=1
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C/C++ Exploits

Determining Platform

C/C++ exploits (exploits are usually coded in C, however on rare occasions they are coded in
C++) are developed usually for two different platforms, Windows & Linux.
You will have to distinguish between the two so you know what compiler to use and what platform
you can use it on. Obviously this section is for people interested in IT Sec that don’t know C/C++
(I highly recommend learning it.) You can easily distinguish between the two by looking at the
header files that the exploit uses in compilation.

Example of Win32 Header Files:

#include <stdio.h>
#include <stdlib.h>

Example 2:

#include <stdio.h>
#include <winsock2.h>

Example of Linux Header Files:

#include <stdio.h>
#include <stdlib.h>
#include <unistd.h>
#include <string.h>
#include <dlfcn.h>
#include <sys/mman.h>

Example 2:

#include <stdio.h>
#include <sys/socket.h>
#include <sys/types.h>
#include <sys/stat.h>
#include <netinet/in.h>
#include <netdb.h>
#include <unistd.h>

I pasted the above from actual exploits taken from milw0rm.
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Most exploits are (apart from those for Web Applications) are written in C.
For compiling (and coding) command line applications my compiler of choice is LCC W32 (I know
I will be criticized for this, but it suits my needs.)
http://ftp.uni-koeln.de/pc/win32/program/lcc-w32/lccwin32.exe

File -> New -> Project

Do you want the wizard to generate the application skeleton?

-> No

Save the exploit as exploit.c (or what ever filename you want.)

-> Click OK

Next -> Next -> Finish

1. Paste your WIN32 exploit code.

2. Compiler -> Make

And now you have your win32 exploit.
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Compiling Linux Exploits

Compiling exploits written for Linux is very simple. And can be done using gcc with comes with
most Linux distributions.

gcc exploit.c –o exploit.exe

Here I compile the exploit:

For some reason it complains at no new line at the end of the file. However it compiles the file
anyway.
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I run the exploit from the command line and it works.

Of course you would pass arguments to the exploit if you were planning on using it.

Note:

Because we are in a *nix environment we wouldn’t normally add the .exe extension when
compiling and running the example exploit. I just have a habit of doing so because I am more of a
Windows user (I am guessing I am going to be attacked now by Linux Jihadists.)

Python

Using Python exploits is very similar to Perl. You will need to download and Install Python.
http://www.python.org/download/
After downloading and Installing Python you may run your Python exploits (example.py) from the
command line.
xml-rpc-exploit.py chk www.postnuke.com /xmlrpc.php
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Above I used a Python exploit to check if a website was vulnerable to an exploit in XML RPC.
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Utilizing Metasploit

What Is Metasploit?
http://metasploit.com/
The Metasploit Project is an open source computer security project which provides information
about security vulnerabilities and aids in penetration testing and IDS signature development. Its
most well-known sub-project is the Metasploit Framework, a tool for developing and executing
exploit code against a remote target machine. Other important sub-projects include the Opcode
Database, shellcode archive, and security research.
http://en.wikipedia.org/wiki/Metasploit

Using Metasploit

Using Metasploit is very simple and there are usually only a few steps to go through.
I will cover going through setting up Metasploit to exploit War FTPd 1.65 which is vulnerable to a
stack buffer overflow.

The first thing we do is open up the Metasploit Console.

We can then grab a list of the exploits available to Metasploit by using the following command:
show exploits
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We now select the exploit to use:
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We use the show payloads command to show the payloads that are available to us.

I choose the win32_bind by doing set PAYLOAD win32_bind:
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We now get a list of potential target operating systems:

We then select our target operating system which is Windows XP SP2:
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After selecting the target we set the Remote Host and Remote Port to exploit:

set RHOST 127.0.0.1

set RPORT 21

If we were using a win32 reverse connect shell we would have to also set the Local Host using:

set LHOST 127.0.0.1 (example only, we would have to use a real world IP Address.)

It is now time for us to launch the exploit, we use the exploit command:

And we now have a shell.

With some exploits you can actually check if the target is vulnerable before launching the exploit
by using the check command (just before you launch the exploit.)
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Metasploit Web Interface

If we launch MSFWeb (Metasploit Web Interface) we get a console listening on a port.

We can then logon to it using a web browser (http://127.0.0.1:55555):

Being the Web Interface is overwhelming simple to use, I will not go through and explain
how to use it.



Aelphaeis Mangarae Blackhat-Forums.com

Greetz To

htek, HackJoeSite, FRSilent, Read101, tomchu, nic`, BSoD, r0rkty/John h4x, Nitrous,
SyS64738, Trash-80, morning_wood, Astharot, Fauley, Furax, PsAuX, SecurityWireless,
SysSpider, Siegfried, fritz, darkt3ch, Predator/ill skillz, headddshot, BioHunter, Digerati,
digital-flow, butthead, spiderlance, FishNET, W--, nrs, IBMWarpst, Nixus, varu, z16bitseg,
PTP, felosi, wicked/aera, HotShowers, spiderlance, Palmeiro, Kadafiu, sNKenjoi, tgo,
melkor, mu-tiger, royal, Wex, ksv, GoTiT4FrE, muon, CKD, Dr4g, dlab, snx, skiddieleet,
ProwL, Edu19, drygol, kon, Iadnah, EwenG, belgther, deca, icenix, j0sh, werx, hybrid,
Cephexin, FLX, kingvandal, illbot, str0ke and Kenny, Blake & Stephen from GSO.

As well as all the people in:

#BHF, #securzone, #darkscience, #Pranks (irc.bluehell.org)
#d-u, #w4ck1ng (EFnet irc.blackened.com)
#ASO, #Social (irc.anomalous-security.org)
#blackcode (irc.uplinklounge.com)
#illmob, #gso-chat (irc.governmentsecurity.org)
#chasenet (irc.datawhore.net),
#xelix (irc.xelix.net)
#remote-exploit (Freenode)
#milw0rm (irc.milw0rm.com)

And of course a couple of other IRC Channels & Networks I won't mention.

RedemptiX – My n00bz0r!

Digerati – Thanks for joining our team at Black Hat Forums.

BlueHell Staff – Thanks for #BHF (IRC.BlueHell.org.)

illbot – You are my whore.

fr4g – R.I.P dude.
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